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Copyright Notice 

The ownership of this manual belongs to SINSEGYE (Shenzhen) Computer 

System Co., Ltd. No one may copy, distribute, translate or otherwise 

use all or part of this manual in any form without written 

permission. 

This manual is protected by copyright law. Any reproduction, 

distribution, translation, display, performance, interpretation or 

use of the contents of this manual, regardless of the purpose, 

requires the explicit permission of China Science Times (Shenzhen) 

Computer System Co., Ltd. Any action without permission will be 

deemed to infringe the copyright of China Science Times (Shenzhen) 

Computer System Co., Ltd. 

SINSEGYE (Shenzhen) Computer System Co., Ltd. reserves the right to 

update this manual at any time and update it without notice. SINSEGYE 

(Shenzhen) Computer System Co., Ltd. does not assume any 

responsibility for any loss or damage caused by the use or reliance 

on the information stated or not stated in this manual. 

When using this manual, you must comply with all applicable national 

laws and regulations. You may not use this manual to conduct illegal 

activities or violate any ethical standards. 
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Chapter 1: Installation and Uninstallation 

Section 1: Installation 

Installation environment requirements 

Recommended for installation on Windows 10 and above 

Download the MetaFacture installation package 

Go to the official website of Sinotech Online Help 

https://www.sinsegye.com.cn/OnlineHelp/index.html, click [Automation Product Line] 

- [ MetaFacture IDE] - [Download Link] on the left side of the homepage, and select 

the desired version Metafacture -<version>-x64.exe from the installation package 

list displayed on the right to download to the local directory. 

 

Installation process 

1. In the same system, multiple MetaFacture versions are not supported to coexist at the 

same time, nor is overwriting installation supported. Please uninstall the old MetaFacture first , 

and then install the new version of MetaFacture . 

2. After the download is complete, enter the local directory and double-click the 

downloaded installation package 
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3. Then follow the instructions of the installation assistant to complete the 

installation . If you are installing MetaFacture for the first time , you need to install the 

dependent software first: click [Install] ( CodeMeter will start after the installation is 

complete , click the close button in the upper right corner to close it) 

 

4. After the dependent software is installed, the MetaFacture installation wizard 

will automatically appear. Click [Next > ] 

 

5. Select [I accept the terms in the license agreement], and click [Next>] 
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6. Select [I have read the information], click [Next >] 
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7. Select the installation path and click [Next > ]: By default, it is installed to 

C:\Program Files\ MetaFacture <version>\ ( recommended installation method ). 

If you want to install to another path, you can click [Change...] and select an 

installation directory . The installation path cannot contain Chinese characters. 

 

8. Select the installation method and click [Next > ]: Select [Complete] to install 

MetaFacture with all its functions (recommended installation method). You can also 

select [Custom] to install some functions. 

 

9. Click [Install], and the Complete installation will take about 20 minutes. 
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10. After the installation is complete, click [Finish] to close the installation 

wizard. 

 

During the installation process, a desktop shortcut will be automatically created on 

the desktop . 

Section 2: Uninstall 

you exit MetaFacture before uninstalling . 

1. Open [Control Panel] > [Programs] > [Programs and Features] 

2. MetaFacture to be uninstalled in the program list , and select [Uninstall (U)] from 

the right-click menu. 
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3. Select [Yes] in the confirmation box that pops up. 

 

4. Wait for the uninstall to complete 

 

5. If some pop-up windows pop up during the process, such as the one shown below (the 

system has both CODESYS and METAFACTURE installed, and it will appear when uninstalling 

METAFACTURE), confirm and close them. 批注 [健弓1]: 中文里面没有对应的内容 
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Section 3: Startup 

1. Double-click the desktop shortcut to start 

2. Or go to the installation directory and click MetaFacture.exe (e.g. C:\Program 

Files\ MetaFacture 1.0.4.0\METAFACTURE\Common\MetaFacture.exe) 
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Chapter 2: Set the user interface language to Simplified Chinese 

Select [Tools] - [Options] from the menu bar , select [Language Settings] on the left side of 

the [Options] dialog box that opens, and specify the user interface language as Simplified 

Chinese. After setting, restart MetaFacture . 
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Chapter 3: New Construction 

Section 1: New Project Panel 

There are four ways to open the [New Project] panel: 

1. In the menu bar, click [File] > [New Project] 

2. ... ] under [Basic Operations] on the start page. 

3. Click the New Project icon on the toolbar 

4. Use shortcut keys Ctrl+N 

The [New Project] panel is displayed as follows: 
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Section 2: Create a new empty project 

1. Open the [New Project] panel, select [Project] as the category, select [Empty Project] 

as the template, enter a custom project name and the location to save the project, and 

click [OK]. 

 

2. Create an empty project with only the project name, and users need to add PLC , 

etc. 
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Section 3: Create a new standard project 

1. Open the [New Project] panel, select [Project] as the category, select [Standard 

Project] as the template, enter the custom project name and project save location below, 

and click [OK]. 
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2. Select a PLC in the [Device (D) ] list (If the corresponding PLC is not found , please 

confirm that the device has been installed correctly. For specific steps, please refer to 

Add Device ) Select a commonly used programming language in the [ PLC_PRG ( P) ] 

drop-down list and click [OK]. 
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3. A standard project is created, including a device [ Device ], an application 

[ Application ], and a [ PLC_PRG (PRG) ] program. 
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Chapter 4: Open Project 

Menu bar [File] - [Open Project], in the opened system file management window, select 

the project file you want to open, and click [Open]. 

Section 1: The [ Project Inspection ] dialog box pops up 

when you open a project created by an earlier version of MetaFacture . It may also pop up 

when you open a project created by a third-party IDE . 

1. Select the last option [ Continue with this version ] and click [ Finish ] 

没能找到截图 

2. The [Project Environment] settings dialog box pops up. If you want to change the 

original project file, you can click [Set All to Latest], click [OK] in the pop-up dialog box, 

and then click [OK] to close the Project Environment dialog box. 
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3. If you want to keep the original project file, click [OK] in the [Project Environment] 

dialog box to close it. Then go to the menu bar and click [File] - [Save As] to save the 

project with a new name. 

 

4. The original project file will be automatically closed without any changes, and 

MetaFacture will automatically open the newly saved project file. Click [Project] - [Project 

Environment] in the menu bar to open the project settings panel, update the module you 

want to update, or click [Set All to Latest] to update all modules. Then save the project 

file. 
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Section 2: Whether to upgrade the project storage 

format 

a project saved by an older version of MetaFacture or a third-party IDE, the dialog box shown below 

may pop up. Select [Yes] to close the dialog box and continue editing the project. 

与中文文档内容不对应 

Section 3: Open Project Error 

After opening the project, click [Compile] - [Generate Code] in the menu bar, and see an 

error in the [Message] window. How to solve it? 
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The device description for xxxx is missing 

Open [Tools] - [Device Repository]. If there is a [Download Missing Description] button on the 

page, click it. This will solve the error reported by the driver that comes with 

MetaFacture . 

 

If a third-party hardware device reports a missing device description error, such as PLC, 

IO module, servo motor, etc., install the corresponding device description file 



  

 — 21 

— 

Unable to open library xxxx (reason: placeholder library xxxx 

cannot be resolved) 

Double-click the error, open the [Library Manager], select the library that cannot be parsed, click 

[Delete Library], and then add it again. 

 

Unable to open library xxxx (reason: library xxxx has not been 

installed on the system) 

Double-click the error to open the [Library Manager], and click [Download Missing Libraries] 

in the opened window. If there is still an error after the download is complete, there may 

be a reference to a third-party library in the code. Install the referenced third-party library, 

and then add the library to the project . 

 

is not available in the installation 

Click [Project] - [Project Settings] in the menu bar and change the [Fixed Version] in 

[Compile Options] to the current version. 

批注 [健弓2]: 在中文文档中未找到 

批注 [健弓3]: 与之前的内容重复 
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Chapter 5: Add / Delete / Export Devices 

This example adds the SX5064 IIoT machine and SRC8200 to MetaFacture . Taking the 

IO module, deleting the SX5064 IIoT machine, and exporting the SRC8200 remote IO 

module as examples, this article introduces how to add, delete, and export devices in 

MetaFacture . When you want to operate other third-party devices, you can refer to this 

example. 

Section 1: Adding Devices 

1. Download the corresponding Sinsegye device description file to your local computer. 

2. In MetaFacture , click the menu bar [Tools] > [Device Repository … ] 

 

3. Click [Install (I)... ] 
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4. Find the directory where the device description files are stored, select [Automatic 

Detection] in the file detection type in the lower right corner , select the SX5 IIoT device 

description file " Sinsegye-x86_64-Linux-SM-CNC.devdesc.xml " and the SRC8200 

device description file " EcatTerminal-SRC_V1.09_ENUM_2.xml " , and click [Open] to 

complete the installation. 

 

Click [Close] to close the dialog box. 
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Section 2: Uninstalling the Device 

1. Click [Tools] - [Device Repository … ] in the menu bar to open the device repository. 

2. Select the device you want to uninstall, click [Uninstall], and select [Yes] in the pop-

up confirmation box. The device will be deleted. 
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Section 3: Exporting Devices 

1. Click [Tools] > [Device Repository … ] in the menu bar to open the device repository. 

2. Select the device you want to export and click [Export]. 
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3. Enter the file name and the location to save the file, and click [Save] to complete. 

The exported file is a compressed package, which can be obtained by decompressing it. 
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Chapter 6: Connecting to PLC 

This example uses the connection of the SX5064 IIoT machine in MetaFacture as an 

example to introduce how to connect a PLC in MetaFacture . When you need to connect 

other models of IIoT machines or third-party PLCs, you can refer to this example. 

Section 1: AI machines are connected to the Internet 

1. Add PLC device description file, refer to Add Device 

2. Create a new standard project , select the newly installed IIoT device in the [Device] 

drop-down list, and click [OK]. 

 

3. Confirm that the IIoT machine is connected to the network and is in the same 

network segment as the computer where MetaFacture is installed. 

 

 

 

4. In MetaFacture , double-click [ Device ] in the device window. On the Device page 

that opens 

method 1 : Enter the IP address of the PLC and press Enter 

Method 2 : Click [Scan Network] and select the corresponding device in the pop-up 
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scan results 

 

5. (Optional) After the PLC is successfully connected, you can rename the device to 

facilitate future device scanning. Click [Device] > [Rename active device], enter a custom 

device name, and click [OK]. 

 

Section 2: The IIoT device is not connected to the 

Internet 

connect the IIoT device to the computer where MetaFacture is installed. 
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2. Set the computer Ethernet IP address and the IIoT machine eth0 IP ( Lan 1 port, IIoT machine 

default 192.168.1.200) in the same network segment 

 

3. Open the [Device] page, click [Scan Network] to scan out the device or enter the IP address of 

the IIoT device 192.168.1.200, and press Enter. 
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Chapter 7: Connecting MetaFacture PLC Simulator 

Connect MetaFacture 's own PLC simulator ( MetaFacture xx Win V3 xx ) to debug 

the project code logic without connecting to the PLC 

Software and hardware resources 

Hardware: 64-bit Windows computer 

Software: MetaFacture 

Section 1: Operational steps 

1. Create a new standard project , select [ MetaFacture Control Win V3 x64] in 

[Device] , and select MetaFacture Control Win V3 for 32-bit operating system. 

If it is a saved project, you can right-click [Device] and select [Update Device]. In 

the pop-up dialog box, select [ MetaFacture Control Win V3 x64], click the [Update 

Device] button, and after the update is complete, click [Close]. 

2. Double-click to open the [Device] page, click [Scan Network] to scan to the 

computer, select the computer, and click [OK]. 

 

3. In the pop-up dialog box, select [Yes] 
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4. The first connection requires adding a device user and setting a username and 

password 

 

5. You need to log in twice for the first login , enter the username and password you 

just set, and click [OK] 
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6. If the status turns green, it means the connection is successful and you can write 

code and run debugging . 

 

Section 2: How to solve the problem of not being able 

to scan the device 

If the device is not found during the scan in step 2, the MetaFacture Control Win 

service may be stopped. Search services.msi in the computer's Start menu to open 

the Windows System Services window and check if the MetaFacture Control Win 

service is running. If it is not running, right-click to start the service. After the service 

is started, return to MetaFacture and scan again. 
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批注 [健弓4]: 没能实现英文系统 
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Chapter 8: Downloading and Uploading Projects 

This example demonstrates downloading a project from MetaFacture to a 

PLC , and then uploading the program from the PLC to MetaFacture on 

another computer . 

System construction diagram 

 

Section 1: Downloading the project to the PLC 

1. MetaFacture in 192.168.110.37 , create a new standard project , 

and select " Sinsegye ..." as the device. 
2. Connect to PLC 

3. Click [File] in the menu bar — [Source code download] 

4. Selecting a PLC 
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5. Menu bar: File - Close project 

Section 2: Upload the project from PLC to MetaFacture 

1. MetaFacture in 192.168.110.11 
2. In the menu bar, click [File] - [Source Code Upload] 

 

3. the PLC to upload the project from the scanned devices. 
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4. Specify the location where the program is placed locally 
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5. Select Open File 
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6. The file is uploaded from the controller to the local computer and opened in MetaFacture . If 

you encounter problems during the opening process, please refer to Opening a Project 
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Chapter 9: Scanning Devices 

This example takes scanning and connecting the SRC8200 EtherCAT IO module in 

MetaFacture as an example to demonstrate how to scan devices in MetaFacture . When 

you want to scan third-party devices, you can refer to this case. 

System construction diagram 

Connect PLC and SRC8200 with a network cable 

Section 1: Adding a Terminus 

1. Connect to PLC 

2. Install the SRC8200 IO module device description file, refer to Add Device 

3. Device ] in the device window , right-click and select [Add Device] 
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4. EtherCAT communication protocol is used , so select the EtherCAT master station: 

[Fieldbus] - [ EtherCAT ] - [ EtherCAT Master ], click [Add Device], and click [Close]. 
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5. Configure the main station 

Set the scanning address. In step 1 , SRC8200 is connected to the Lan3 network port, so 

select eth2 ( eth serial number starts from 0 , so it is 1 less than the Lan serial number ) 
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Expand [Options] and check [Automatically restart slaves] . 

 

Section 2: Scanning Slaves 

1. Click the [Login] button on the toolbar to log in to the PLC. If the following message 

appears, click [Yes] 
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2. In the device window, select the master station [ EtherCAT Master ], right-click and 

select [Scan Devices] 

 

3. If the above configurations are correct, you can see the scanned devices on the Scan 

Devices page. The models and order are consistent with the models and order of the 

actually connected physical devices. After confirmation, click [Copy all devices to 

project] (If no scanned content is displayed, or the scanned content is incorrect, 

please click [Scan Devices] in the lower left corner to try again) 
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4. Click the [Exit] icon on the toolbar and the IO module will be added to the device tree. 
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Chapter 10: Installing and Using Libraries 

This example takes the HTTPClient library as an example to demonstrate how to install, 

uninstall, export, and use the installed library in MetaFacture 

When you need to operate a third-party library in MetaFacture , you can refer to this 

example. 

Section 1: Installing the Library 

1. xxxx.library ) you want to install to your local computer 

2. In MetaFacture , click [Tools] - [Library Storage ... ] in the menu bar. 

3. Click [Install], select the downloaded library file, and click [Open] 

 

4. Installation complete, close the dialog box 
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Section 2: Using the library in your project 

1. Create a new standard project 

2. In the device window, double-click [Library Manager] 

3. Click [Add Library], enter the name of the library you want to add, select the library 

you want to add, and click [OK] 
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4. After adding the library, check the [Message] window for errors. If the following errors are 

found, install the missing dependent libraries. 

 



  

 — 49 

— 

5. [Message] The window displays "0 errors", and you can directly define and use the 

function block in the program. 

 

6. you do not find the library you want in the filter results in step 3 

a. Please check whether the search library name you entered is correct. 

b. Please make sure that the library has been installed. If not, please install the 

library first. If you are not sure whether it has been installed, you can click [Find] in 

the [Library Storage] dialog box to see if the library can be found. If not, it means 

that it has not been installed. 

Section 3: Uninstalling the library 

1. In MetaFacture , click [Tools] - [Library Storage ... ] in the menu bar to open the 

Library Storage 

If you cannot find the library you want to uninstall, you can click the [Find] button on the 

[Library Storage] page, enter the name of the library you want to uninstall, select the library 

you want to uninstall in the filter results, and click [Open]. 
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2. Select the library you want to uninstall and click [Uninstall]. 

 

3. Close the dialog box when the uninstallation is complete 

Section 4: Exporting the Library 

1. In MetaFacture , click [Tools] - [Library Storage ... ] in the menu bar. 
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If you cannot find the library you want to export, you can click the [Find] button on the library 

storage page, enter the name of the library to be exported, select the library to be exported 

in the filter results, and click [Open]. 

2. Select the library you want to export and click [Export]. 

 

3. Select a folder to save, enter the [File Name], and click [Save] 
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4. Close the dialog box and go to the specified save folder to view the exported library 

file. 


